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What RBC Pages Should Be Submitted?

For the year-end 2017 health risk-based capital (RBC)
filing, submit hard copies of pages XR001 through
XRO027 to any state that requests a hard copy in addition
to the electronic filing. Beginning with year-end 2007, a
hard copy of the RBC filings was not required to be
submitted to the NAIC. Other pages, such as the capita-
tions worksheet, do not need to be submitted. Those
pages would need to be retained by the company as docu-
mentation.

Business Risk—Excessive Growth Charge
For Start-Up Companies

As a result of the adoption of agenda item 2014-28-H
(MOD) by the Capital Adequacy (E) Task Force at the
2016 Fall National Meeting, new footnotes were added
to page XR021 for the use of projected amounts in

prior year Line (13) and Line (15), along with ang,

explanation of the projections used.

Money Market Mutual Funds

As a result of the reclassification of money mn
mutual funds (MMMFs) to cash equivalents by t
Statutory Accounting Principles (E) Workig§ Group,
the Capital Adequacy (E) Task Force ado agenda
item 2016-15-CA at the Spring Nati ing.
MMMFs will be isolated on thejg®ow @ der the
Miscellaneous Fixed Income A SRtiopon page
XR007 and subtracted from the cashifgguivalents. The

Annual Statement Source Wgilhbe ScheGule E, Part 2,
Column 7, Line 8599999.

Operational Risk

As a result of a technical issue that wa
June 28 Capital Adequacy (E) Tas
implementation of a risk facto
been deferred for at Ieastg yes

m Task Force adopted
agenda item 2016-13-0O at t aJdNational Meeting and
c
r

modified it on its June rence call. At the Spring
National Meeting, the in essence voted to “go
dopting the structural change to

remove the basic o isk options from the informa-

tional-only : the growth risk portion in the
informatign > % e, and move the “add-on” approach
nalgdrisk to Page XR025. On its June 28

but duce the recommended RBC charge from
W to for 2017 to allow the Operational Risk (E)
{Uhgf G to address the technical concerns raised.

for basic oggra
conferenag®c he*Task Force adopted the operational risk
ins%or ges XR002, XR022 and XR024-XR025,

Benefits within Stand-Alone
cdicare Part D Coverage

As a result of the adoption of agenda item 2016-16-CA by
the Capital Adequacy (E) Task Force at the Spring National
Meeting, the factor for Supplemental Benefits within Stand-
Alone Medicare Part D Coverage (Page XR014, Line (22.1))
was increased to 0.500 and will be applied to claims
incurred.

Stop Loss

As a result of the adoption of agenda item 2016-17-CA by
the Capital Adequacy (E) Task Force at the Spring National
Meeting, a tiered factor approach will be applied to stop loss
premiums. A footnote was added to page XR014, Line (22)
to apply a factor of 0.350 to the first $25,000,000 in stop loss
premium and a factor of 0.250 would be applied to premium
in excess of $25,000,000.

Unaffiliated Common Stock Money Market
Mutual Funds

As a result of the adoption of agenda item 2017-06-CA, by
the Capital Adequacy (E) Task Force on its June 28 confer-
ence call, the annual statement reference was modified to
Schedule E, Part 2, Column 7, Line 8699999 and the factor
was modified to 0% on Line (17) on page XR009. The
purpose of the modification was to avoid the double count-
ing of MMMFs in both cash equivalents and common stock.
The instructions were also revised to reflect the change.



Editorial Changes

1. On page XR002, the column name was updated in Column 4 to reflect the changes to page XR025, page PR032 and
page LRO31 for Operational Risk. The column name was changed to “Affiliate’s RBC After Covariance Before
Operational Risk” and the line number for life was changed to Line (67) + (70) and the line number for P&C was

changed to (73).
2. On page XR022, the references to P&C Supp. Sch. F, Ptl, C5, L0899999 and P&C Supp. Sch. F, Ptl, C5,

0999999 were removed from the Reference column for Line (2), Line (3), Line (6) and Ligmg(7) as a result of
Proposal 2017-01BWG, adopted by the Blanks (E) Working Group on its June 14 conferencagtall.

3. The column reference in the instructions for Line (18) on page XR023 was corre ‘Column (2)” to
“Column (3).” L 4

4. The annual statement reference was updated from Note 51 to Note 5M on Lin ) 24) on page XR007 as a
result of proposal 2017-13BWG (MOD), adopted by the Blanks (E) Working p Sggdrs June 14 conference call.

5. The annual statement reference was updated to Schedule E, Part 2, Colum Ling¥8699999 on Line (17) on page

N
&

© 2017 Natiolf§Association of Insurance Commissioners M Direct correspondence to: Crystal Brown, RBC News-
letters, NAIC, 1100 Walnut Street, Suite 1500, Kansas

City, MO 64106-2197. Phone: (816) 783-8146. Email:

Published annually or whenever needed by the NAIC for @ Address corrections requested. Please mail the old
insurance regulators, professionals and consumers. address label with the correction to: NAIC Publications
Department, 1100 Walnut Street, Suite 1500, Kansas
City, MO 64106-2197. Phone: (816) 783-8300. Email:
prodserv@naic.org.
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The Health RBC Forecasting CD-ROM contains a spreadsheet that calculates RBC usimg, the same
formula presented in the 2017 NAIC Health Risk-Based Capital Report Includindl Ovelgdew &
Instructions for Companies. (A hardcopy of this booklet is mailed with the forecastin -ROM or is
available for download from the NAIC Publications Department.)

This forecasting spreadsheet can be used to check RBC results throughout t

0
RBC results before the RBC vendor filing software may be available, or to e%at-if" scenarios.

User Requirements

* A Microsoft Windows® rsion of
Microsoft Excel 2010 patible

versions).
e Four megabytes of h
e A good understan

software.
MO M

To install the deheet files, start Windows
Explorer CD-ROM drive where

Installation fro

Copy Paste the Forecast Health 2017
B file in the directory where you
would like the file to be saved.

© 1998-2017 National Association of Insurance Commissioners
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early look at

About the File

The spreadsheet Forecast Health 2017 10
20.xIsm was created in Microsoft Excel. The
spreadsheet can be used with Microsoft Excel
version 14.0 or higher. The spreadsheet
includes menus for use in navigation between
pages and for printing.

The RBC spreadsheet above follows the 2017
NAIC Health Risk-Based Capital Report
Including Overview and Instructions for
Companies formula pages. A copy of the
instructions and blank are included with the
CD-ROM to assist in the completion of the
forecasting file.



Usage

1. Open the Forecast_Health_2017_10-20.xIsm file by double clicking on the file.
2. Enter data as described in the following sections and examine the results.
3. Save any changes to the spreadsheets using the “Save” command from the “File” menu.

Please Note

In certain versions of Excel, the user may receive the following message when the fore file

is opened:

y $ecarity Warning  Some active condent hag been digsbded. ok 1o mare detaif. Eutrh

If this is the case, the user would need to click on the “Enable Content” b .

To change the Excel security level, go to the Developer tab, in the Cgde gr click Macro
Security. In the Macro Settings, select the security option.

Macs Settngn
i o ¥ Record fiacre Crabie @it muaqelwrihay
8] 589§ Qinasl !4
Wiud Mades o
Bakid
Sid peofinkady dasgersa code Lin mn
Data Entry

The spreadsheets have been color-coae

» Blue-shaded cells are data elements'§gai#tie directly to the 2017 health annual statement
(i.e., vendor link items). This dgia can beYound in the company annual statement filing.

e Red-shaded cells are data el@&3ents that are not available directly from the annual statement

(i.e., manual data entry i e items come from other company records as noted in the
spreadsheet.
e Cells that are not elements calculated automatically by the spreadsheet. These

cells are protected.
e Green-shadeg, cells are elements that must be entered using a separate input worksheet.
Clicking on t Il will automatically take the user to the input worksheet. Data input into the
he

separate wQ | feed automatically to the main page.

What- %

ique features of the forecasting spreadsheet is its ability to perform what-if
cause the formula is implemented through the Excel spreadsheet, the user is able
to run Vgious scenarios by adjusting the book/adjusted carrying value, amount or statement value
to analyze the effect such changes would have on the company’s overall RBC ratio based on the
RBC factors and covariance.

© 1998-2017 National Association of Insurance Commissioners
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Saving and Exiting

To exit the program, simply click the in the upper right corner of the file or choose the
“Exit” option from the “File” menu. The spreadsheet program will prompt to save any files which
have been changed.

* Answer “yes” to save any changes such as data input or formula changes.
e Answer “no” if saving is not desired. Warning: This will ignore any and all othergchanges
made.

Printing

A print menu was added to the Microsoft Excel file to aid in printi@. C @ cach box
next to the page name for the individual pages that are desired to et hen select
the button for “Print Selected Pages.” Select the “Reset” button arfy§me W is desired to
have all buttons deselected. Individual boxes can also be deselected liCRIfg on them.
RBC Forecasting Tips

1. Make sure the CD-ROM is retained so a back-up copygf @ ile is available. The NAIC
will not replace the CD-ROM unless it was damaged durig sigaisfg or is otherwise defective.
tion before beginning. In some

2. Gather information required for the affiliated investrpfnts
instances, information will need to be gathered fr rious affiliates themselves.
3. Keep a copy of the NAIC annual statement blank% statement instructions nearby and
refer to them as needed.
4. Keep the copy of the RBC Overview and‘nst%t the computer to be used as a reference
ee

while filling out the spreadsheet. The spre ws the RBC Overview and Instructions
formula pages exactly.
5. Make a list of questions while £
saving both parties time.
6. When leaving voicemail messages, mawgdiie question as specific and detailed as possible. We
will then be able to call bacthe anSwer, saving time spent on the phone. Please leave a

e spreadsheet. Then call the NAIC staff once,

phone number or email addresgyand we will get back with an answer as soon as possible.
Questions and Supp

If problems are encount please refer to the Health RBC Overview & Instructions booklet
and/or the ForeWre heet Instructions. However, if there is still a question, contact the
NAIC.

For qugstio

@ ning to annual statement references, insurance accounting questions or
formula ns_gontact Crystal Brown.

b

Fo age related questions (loading the product, etc.), contact the NAIC Help Desk.

Importar®t Contact Information

e RBC Formula questions: Crystal Brown, (816) 783-8146 or cbrown@naic.org.

e Computer questions: NAIC Help Desk, (816) 783-8500 or help@naic.org.

e Annual statement questions: NAIC Financial Reporting Questions Help Line, (816) 783-8400.
e Questions on publications: NAIC Publications, (816) 783-8300 or prodserv@naic.org.

© 1998-2017 National Association of Insurance Commissioners
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NAIC

National Association of Insurance Commissioners

The National Association of Insurance Commissioners
(NAIC) is the U.S. standard-setting and regulatory support
organization created and governed by the chief insurance
regulators from the 50 states, the District of Columbia and five
U.S. territories. Through the NAIC, state insurance regulators
establish standards and best practices, conduct peer review,
and coordinate their regulatory oversight. NAIC staff supports
these efforts and represents the collective views of state
regulators domestically and internationally. NAIC members,
together with the central resources of the NAIC, form the
national system of state-based insurance regulation in the U.S.

For more information, visit www.naic.org.
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